®_J WOLF STAR

I F C H N O | O G | E S

True-Load Enhancements
2023-10-22

Tim Hunter




Enhancements Overview

Great updates in this release!!!

Most of the enhancements discussed in this document are
updates in performance and usability

Some new features have been added.

51 Enhancements, 5 Bug Fixes
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Overview — Major Enhancements

TFU — Subtract Functions

Recent Files — Save lots file browsing

Hybrid Loading — No gauges needed!

Time to Cycle / Angle mapping

Units in TFU Fatigue

Speed up of GOI / Test Data Compare

Scratch Files relocated

3D STL of realistic strain gauges

Purge intermediate files for Hybrid and Contact Control
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Bug Fixes
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Bugs

Module Type Description

TFU
QSE

PRE

TFU

POST

Bug
Bug

Bug

Bug

Bug

When double clicking TFUfile from OS, checking plot
file name in TFU Mgr prints nothing for the title.
Relative pathsand ODS

RoboGauge -- cogDict key not initialized in the TLD
dictionary.

Change file open dialogtoonlyallow *.TFU --
previously * was available too.

Disable "Relative Path"in QSEfiles during Post-Test
runs. Paths get confusedin QSE after Post.
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Enhancements — True-Load Environment

Highlighted Records Documented on Details page

Module Type Description Release Doc
ALL  Enhancement Enable Square axis scaling X
ALL Enhancement Meaure Utils: Measure Element to Element X
ALL Enhancement New TFU Tools Icon
ALL Enhancement Re-structure WST_scratch files X
ALL Enhancement Add Square Axis plotting to Plot Widget X
ALL Enhancement Tools Menu --> Show Scratch dir X
ALL  Enhancement Update the installerfor WST_scratch X
ALL  Enhancement Add recentfiles options (menu, auto-completion) X
ALL Enhancement Re-organize Tools Menu X
ALL  Enhancement Install via configfile TBD
ALL  Enhancement Upgrade Reprise licensing version 15.1 TBD



Enhancements — TFU Mgr

Highlighted Records Documented on Details page

Module Type Description Release Doc
TFU  Enhancement Map time data to Cycle / Angle data TBD
TFU Enhancement Subtract Functions X
TFU Enhancement Subtract two TFU Files X
TFU  Enhancement Add units to TFU Fatigue Material Definition TBD



Enhancements — Gauge Dimensioning

Highlighted Records Documented on Details page

Module Type Description Release Doc
Fix drawing plane issue -- Make draw plane the
DIM Enhancement plane of the element TBD

Store Dimension settingsin user home dir and auto
DIM Enhancement load X

Make Dimension lines / text always visible - no
DIM  Enhancement hidden line processing



Module Type
PRE Enhancement
PRE Enhancement
PRE Enhancement
PRE Enhancement
PRE Enhancement

Enhancements - Pre

Description

When browsing for FEA DB, set type to current FEA
DB type

Draw Gauge Lines- 3D STL - ExportOne STL per
Gauge checked off by default

STL files for Strain Gauge Representations

Reformat print out of eMat, eScales and pScales --
faster printing

Minor GUI Changes

Highlighted Records Documented on Details page

Release Doc

X

TBD



Enhancements - Post

Highlighted Records Documented on Details page

Module Type Description Release Doc
On Hybrid Loading and Contact control have a
Post Enhancement switch to purge auxiliaryfiles X

Update Hybrid loading to use QSE to generate
strains -- eliminate need for gauges on hybrid load

POST Enhancement cases TBD
Update Batch Mode to supportthe WST_scratch file

POST Enhancement structure

POST Enhancement Reformat report header TBD



Enhancements - QSE

Highlighted Records Documented on Details page

Module Type Description Release Doc
When browsing for FEA DB, settype to current FEA
QSE Enhancement DB type X
QSE  Enhancement T3D Outbox full width with SaveAS button
Huge speed increase in Compare GOI -- Reduce plot
QSE  Enhancement density for adjacent elements TBD



Installer and GUI-Less Install




Installer GUI Update

€) Wolf Star Technologies Installer - O bt

WOLF STAR

T ECHNOLOGI E S

Destination Directory: |C:"|.TFUELOEIdApp | (=~ browse
= 0 0 0 Or AC
Python 3.6 | Anaconda 4.3.1 (64-bit) Directory: |D:\Anac0nd33 | = browse
Default FEA: |:| Install Abaqus CAE Plugin do 0ad - ® o.0 N enable
|:| Open as VTFx |:| Download Ansys WorkBench Plugin
C O C 0 > d O C Od(
Shortcut Location (e.g. Desktop): |C:\Users\TimHunter\DneDrive - Wolf Star Technologies\Desktop | == browse
Default work dir (for shortcut): |C:r’scratch | = browse
WST_scratch Location: |TEI'-‘IP - | |C:‘\,Users\,T]NHUN~1MppData‘\,LocaI\Temp
Licensing Path -- Optional Everyth I ng else
(e.g. port@host; <path to LiC file>): |5053@WST11 | = browse
9 ’ ' works the same as

| Install | ‘ Cancel | ’ ﬁ Get instaIIConﬁg.p; before




1) Get the installConfig.pyfile

WOLF STAR

T ECHNOLOGI E S

Destination Directory: |C:\TrueLoadApp | [= browse

Python 3.6 | Anaconda 4.3.1 (64-bit) Directory: |D:\ﬁnac0nd33 | = browse

Default FEA: |*.0db ~ | [] Install Abaqus CAE Plugin
[ ] bownload Ansys WorkBench Plugin

|:| Open as VTFx

Shortcut Location (e.g. Desktop): |C:\Users\TimHunter\DneDrive - Wolf Star Technologies\Desktop | [= browse YOU W| ” browse for a fOIder to

Default work dir (for shortcut): |C:fscratch | [= browse store this file in.

WST_scratch Location: | TEMP - |C:".,Users".,T]]\"IHUNNl\,ﬁppData\LocaI\Temp |
Licensing Path -- Optional
(e.g. port@host; <path to LiC file>): |5053@WST11 6 & browse

Install Cancel ’

23

Get installConfig.py




installConfig.py

installConfig.py

Configuration file for automating / prepopulating installation parameters

e e

This is python, all paths should be preceded by "r" (r=raw text string)

e Edit the installConfig.py to suite your
B o e environment.

import os
from win32com.client import Dispatch
shell = Dispatch('WScript.Shell')

=

# _____________________________________________________________________________

# Helper variables

# _____________________________________________________________________________

winDeskTop = shell.SpecialFolders ("Desktop") # Path to Windows Desktop

winTemp = os.environ['TEMP'] # Path to Windows Temp directory

homeDrive = os.environ|['HOMEDRIVE'] # User Home Drive

homePath = os.environ['HOMEPATH'] # User Home Directory

homeDir = os.path.join (homeDrive, homePath) # User Home Directory (full path)
fo=======—mmommooeo oo e

# User variables

# _____________________________________________________________________________
unAttendedInstallFlag = True # --> True = No GUI, False = GUI

destDir = r'C:\trueLoadApp' # —--> True-Load Application Destination

defFEA = '*_ odb' # —--> Default FEA ['*.odb', '*.rst', '*.op2', '"*.h3d', '*.neu']
openAsVTFxFlag = False # —--> Converts FEA to VTFx; True=0On, False=0ff
shortCutDir = winDeskTop # --> Location for True-Load shortcut

shortCutWorkDir = winTemp # —--> Working directory for True-Load Shortcut
scratchDir = 'TEMP' # --> WST scratch location ['HOME', 'TEMP', <path>]
licenseVar = 'WOLFSTAR LICENSE' # —--> value for WOLFSTAR LICENSE *** DO NOT CHANGE ***
licensePath = '5053Q@WST11" # —--> Location of license server or file [port@host, <path to LIC file>]
# *** Optionally ***

pythonDir = None # —--> Location of Python [None, <path>]

postInstallScript = r"C:\scratch\helloWorld.bat" # Path to script to be run post install [None, <path>]




Unzip the installer

Method 1: 7Zip

Junk
&) Name

E True-Load_Installer_2023-10-20.exe
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Open

Run as administrator

Share with Skype

Edit with Motepad++

Maunt as ImDisk Virtual Disk
Edit with CLion

Eo&

Troubleshoot compatibility
Pin to Start

@ Move to OneDrive
T-Zip

Scan selected items for viruses

2

Size

279,248 KB

Open archive

Open archive

Extract files...

Extract Here

Extract to "True-Load_Installer_2023-10-200" L\\!
Test archive

Method 2: Zip

1) Rename EXE to ZIP

i Edit with Motepad++
Mount as ImDisk Yirtual Disk
= | junk @ Edit with CLion

Home Share

B0

ick Copy Paste

Extract All...

]
Clipboard Create shortcut

Delete

Rename

Properties

- O
/] 5 |[®
,perties Select
- @ -
COpen
W] A& Search junk
Type

o oL

Compressed (zipp...

'
279,241

Size

[T}



Copy installConfig.py to installer folder

BE C:\Windows\System32icmd.exe

= | True-Load_Installer_2023-10-20

. s a 2 18-2@>tlInstaller.bat
“ Home Share View

4 cut x . D B Open - H select all hon tlInstaller.py
+ ' o E -

! w.| Copy path 1= Edit Select none
uick Copy Paste Move Copy Delete Rename New Properties
Paste shortcut tor tor - folder - & History Invert selection
Clipboard Crganize MNew Open Select
<« v » ThisPC » Downloads » junk » True-Load_Installer_2023-10-20 » v | @ Search True-Lo .||
- Name Date modified Type Size
leons 10/2 53 PM File folder
P config. 8/ PY File
9-py

P installConfig.py 10,2 PY File

i installConfig.zip ! Compressed (zipped) F...
" tlinstaller.bat a/ Windows Batch File
a [ ) tlinstaller.py 10/20/ PY File P gl ol _____
- { trueloadApp_2023-10-20.zip 10/20¢ =Ccmp|'E-_'-£E:I-:ippe:_I;P“/
WolfStar.wbex 10/ WBEX File i :

& wst_info.bxt 5/27 ! Text Dy/ dating I;.»'-".TH riable. ..

E] wstabqinstaller.exe 10/18/2023 £:07 PM e Open Methods / File Icons...
=1

Requesting :
v < finished.

10 items 1 item selected 2.23 KB

/

Run tlinstaller.bat

Hello World

chnolog
tallation
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Reprise RLM Update
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Reprise RLM Update

* True-Load license management

system is now running on the repr ise

latest version of Reprise RLM SOFTWARE
Software.
RILM v1s.1
e This should eliminate any security
concerns. .~\|)l'i|. 2023

* It will not affect any current S
license installs.
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True-Tools Help

€ Wolf Star Techneologies True-Tools
True-Suite  Cloud Draw Style

S 4% % Ha Tle

=

Help

@ -

View Too

uED_i
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I_Tc-ols 3

idgets

Ruler

Mode Info

S
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Elernent Info

There are some

changes to the Help
form and updatesto
the documentation.

All Cross-Plots
@ CAEVTFx
~ W Generate Random Strains d
¢ Gauge Transform Wizard

Print Current Working Cir
Change Working Directory

>
>
& Edit Config
o
i
(=

Cl

¥ True-Tools Help

Cl
|

3rd Party |

© 2010, Wolf Star Technologies
ALL RIGHTS RESERVED
Version: Ceetron 2022-08-25

— — L L — ,
©  True-Tools Help

www.wolfstartech.com

———

~ M Common Tools
- .

r A Common Tools Help ‘TFUE'QSE

I True-QSE Help True-LDE

/3 True-LDE Help I True-Load

/1( True-Load Help B TFU M 3 nager

A, TFUM Help
7 2 il o g Duty Cycle

-* ]
iﬁDuty Cycle Help —
M NMeasure Utilities

4 Measure Utilities Help

@PythonSheuHelp = pPython Shell

.tfuTooIs Help '™ tfuTools

1; Support Portal




Abaqus Plugins

ABAQUS




Abaqus Plugins

Tools

Widgets rlalg B @ At WinZip Self-Extractor - wstabglnstaller.exe
%‘5 Measure Utilities b
Q) Protractor WinZip Self-Extractor n Set
% Ruler E
:P MNode Info Cancel
BD  Element Info True-Load(c), True-QSE(c), True-LDE(C)

Tl Een e are registered copyrights About

by Wolf Star Technologies, LLC

CAWINDOWS\system32\cmd.exe — O >

B CAEVTR
i

Generate Random 5trains on TLD ) ) ) i
Unauthorized use, sale, duplication or deri

.-:f, Gauge Transform Wizard . ] o .
is stricly prohibited under US Copyright p

\>  Print Current Working Dir

.,' Change Working Directory

& Edit Config

- ["" Clean Up Scratch Files

~ ds  Update True-Load Software

@ Check License Status r-
3rd Party Plugins P @ Install Abagus CAE Plugins

© True-Tools Help @ Download Ansys Workbench Extension

{"} About

e |



Plugin installer creates
<HomeDir>/abaqus plugins.

This is a standard folder that
Abaqus/CAE looks in for plugins.

The WST plugins are in a subfolder
calledwst_plugin central.

Abaqus Plugins

I ¥ = | abaqus_plugins — [m| X

Home Share View /\ e
* L'l & Cut x I 1 New item ~ ‘/-I 4 Open H select all
Wl Copy path "‘:I ﬂ Easy access ~ - Edit Select none
Pinto Quick Copy Paste . Move Copy Delete Rename New Properties X
access [#] Paste shortcut to to - falder - 4 History = Invert selection

Clipboard Organize Mew Open Select
« v » Tim Hunter » abaqus_plugins » v | O £ Search abaqus_plugins

~
# Quick access

B Desktop »*
4 Downloads o
= Documents E :’_
= Pictures g ::'
p—— —
_rsgTrmpDir wst_plugin_central generic.lib
-

@ OneDrive - Personal
v

3 items



Abaqus Plugins

% Abaqus/CAE 2020.HF4 [Viewport: 1]
[Z] File Model Viewport View Result Plot Animate Report Options Tools fPIug-ins Help K?

LEEms g oK) CR.E LIRS T »c—»»gg/ﬁqn@
o r}jmpnmary VI v \‘,\'-I*(’ ~\D«ETL? A . w |\ L_“:'@

Composites Modeler

Model Results Module: |3 Visualization Edit Function Name ) . ) ) ) .
Interpolate Func FOX The plugins will appearin the Visualization

Session Data Vr s B % @ A2 ] i i i H
‘ o Lincar Extrapoiostion R Module of Abaqus CAE in the plugins menu.
Output Databases .g::: Pad And Sync FOX
# &5 Model Database (1) — Race Track FOX In Abaqus CAE the user may create toolbars to
@ [ Spectrums (7) . 5,% Remove Drift FOX easily point to the plugins_
BH XYPlots & .. Snip Function Fox
B8 XYData g !]"!35 Tools >
& gathls . 5 H L E W Gauge Dimensions
# 5y Display Groups n M - _—
B Free Body Cuts -y, A i i Loy True-Suite [ %
@ Streams ]}J ‘gfff /1/ Standalone Pre-Test : / lg qﬁ JqL
I Movies s ‘\’O Standalone TFU Manager . :

Images = =
3 JQLStandalone True-LDE

' " Standalone True-QSE
When viewing an ODB in Abaqus CAE, the user my choose True-Load/Pre-Test (or Utilities >
QSE, or LDE) and True-Load will launch, load in the ODB and name the TLD (or QSE or © WsTHelp

LDE) file with the same name as the ODB. This makes it super simple for the firsttime

creation of a True-Load file from Abaqus CAE.

N  © 1



Ansys Plugin




Ansys Plugin

True-Suite  Cloud Draw Style View Tools

oA %t b & I Weses R @ At WBEX file installed in Ansys

@ Measure Utilities
e Potractor Workbench
State \ Ruler

:P Node Info
Contour Style Contour

: All Cross-Plots &3] Cumpgnent Sysm
Vector Result No selection @ CAEVTRx
Filter M Generate Random Strains on TLD B wolf StarTechnolugles
Contour Vector #: Gauge Transform Wizard @ CAE2VTFX
-—

Data Type \> Print Current Working Dir = Duty Cycde Manager
Data Component [# Change Working Directory “¥ Post-Test
Data Location & Edit Config ;\.‘ Pre-Test

™ Clean Up Scratch Files L TE

. 3 . Py LI Manager
Single  Series  Options g @ Update True-Load Software ' g
@ Check License Status ‘* True-LDE
. F z
3rd Party Plugins Y @ Install Abagus CAE Plugins [y True-QSE
© True-Tools Help @ Download Ansys WorkRench Extension 1 ‘ M ACT

(2]

About I

L

WBEX extension
Results Mgr Group Mar Part Mgr XY Mar
Gonsole Output downloaded to Desktop

U= TUUTS APPIICaCION JUITT
Copyright(c) 2010 -- ALL RIGHTS RESERVED
True-Suite Version: Ceetron 2022-88-25

Powered by Ceetron 3D Components 3.9.0

Session Start: Mon Aug 29 ©9:36:20 2022 O
Opening Main Window
Installing Abaqus CAE Plugln...
o ol g el @ e g0 Yy i b e e i el e T el 5 e L [ il e e e e e e e e e e
I Downloading Ansys PlugIn (WolfStar.wbex) to Desktop -
e




Time to Ang / Cycles




Time to Ang / Cycles

Time to Ang / Cycles will map time domain data to angles or cycles.

This is especially useful if your structure is a rotating component
(e.g.):

— Engine

— Conical Crusher

— Generator

— Wheel

The user needs to provide an angle channel sampled at the same
sampling rate as the data.

The angle data needs to vary from a low value to a high value (e.g.
0 to 360, 0 to 720, etc.)

N —( ]



Example data

300 A
Gage01

Gage02 350 1
Gage03
Gage04
Gage05 300 7
Gage06
Gagell
Gagel2 250 1
Gagel3
Gageld
Gagels
Gagel6
Gagel7
Gage20
Gage21
Gage22
Gage23 100 +
Gage24
Gage25
Gage26 50 1

200

— dngle

100 +

200 A

o
1

150 4

Strain (microstrain)
Angle (Deg)

-100

-200

T T T T T T T T T T
20 40 60 80 100 120 140 160 180 20 40 60 80 100 120 140 160 180

Time (s) Time (s)



Map Time to Cycles

€ TFU Manager 7 x
TFU File | @ | ‘ D:/scratch/Metso/5065 Load Recovery/Test Data/showAngCycitest tfu ‘ @ o GE @ t" Wolf Star Techn c|.|c|.gie5 True-... ? 4
Select Function Name 2

" il i

15 Gage21

16 ge22 Diegress per Cycle:  [350.0
" L @ Map o e

O Map to Angles Store Total Angle

20 Print progress I:' Replece Channsls

Angle Channsl: Angle

Apply

24 [] Angle v
Manage Math

Import Export
e gl @b : SR
Madify y}f Reciprocal
] e ] P o R P 2 1

2
S
Plot Options y D ]
Simple v | [ Legend Title:  None ~  Font Size:E ‘\I_ Square Root

Absolute Value

Derivative P

d
@
ﬁ'dt Integrate

9 ©2010, Wolf Star Technologies ALL RIGHTS R




Map to Cycles

300 A

200

100 +

Strain (microstrain)

-100

-200

Gage01
Gage02
Gage03
Gage04
Gage05
Gage06
Gagell
Gagel2
Gagel3
Gagel4d
Gagel5s
Gagel6
Gagel7
Gagez0
Gage2l
Gage22
Gage23
Gage24
Gage25
Gage26

20

60

80

T T
100 120

Time (s)

T
140

T
160

T
180

100

50

200 A

100 4

Strain (microstrain)

-100 +

-200 +

50 4

—— Gage01_v_cycles
—— Gage02_v_cycles
—— Gage03_v_cycles
—— Gage04_v_cycles
—— Gage05_v_cycles
~—— Gage06_v_cycles
—— Gagell v_cycles

—— Gagel4 v_cycles
—— Gagel5_v_cycles
~—— Gagel6_v_cycles

| | — Gage20_v _cycles

—— Gage2l_v cycles
—— Gage22_v_cycles
~—— Gage23_v_cycles
—— Gage24_v_cycles
—— Gage25_v_cycles
—— Gage26_v_cycles
—— Gage27_v_cycles
—— Gage28_v_cycles
—— Gage29_v_cycles

5SS

7200 7300

Gagel3 v_cycles
Gageld v_cycles
Gagel5 v _cycles
Gagel6_v_cycles
Gagel7 v cycles
Gage20 v _cycles
Gage21 _v_cycles
Gage22 v cycles
Gage23_v_cycles
Gage24 v _cycles
Gage25 v_cycles
Gage26_v_cycles
Gage27 v _cycles
Gage28_v_cycles
Gage29 v _cycles

0

T
5000

T
10000

T T
15000 20000

Cycles

T
25000

30000

T
35000

T
40000



Map to Angles

15 Gage21

24 [] Angle

€ TFU Manager 7 x
TFU File | @ | ‘ D:fscratch/Metso/5065 Load Recovery/Test Data/showAngCycitest.tfu ‘ @ o GE @ ﬂ Walf Star Technnlcl-gies True- ri :‘_5{
Select Function Name ~
" el b

Angle Channel: aAngle

Degrees per Cycle:  (380.0

() Map to Cycles

@ Map to Angles |:| Store Totzl Angle

Print progress |:| Replace Channels

Apply

Manage

Modify

= Ly o 28 W) By i

Math

ZA

Walltin vl 4 “NAM Aev /\0 N ly

%y

7y

|
yz

Plot Options
Simple - Legend Title: Mone ~ | Font Size: E ‘\I_
9 ©2010, Wolf Star Technologies ALL RIGHTS R
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Map to Angles

300 A

200

100 +

Strain (microstrain)

-100

-200

Gage01
Gage02
Gage03
Gage04
Gage05
Gage06
Gagell
Gagel2
Gagel3
Gagel4d
Gagel5s
Gagel6
Gagel7
Gagez0
Gage2l
Gage22
Gage23
Gage24
Gage25
Gage26

20

60

80

T T
100 120

Time (s)

T
140

T
160

T
180

Strain (microstrain)

200 A

100 +

-200 A

Gage0l_v_ang
Gage02_v_ang
Gage03_v_ang
Gage04_v_ang
Gage05_v_ang
Gage06_v_ang
Gagell_v_ang
Gagel2_ v_ang
Gagel3_v_ang
Gagel4 v_ang
Gagel5_v_ang
Gagel6_v_ang
Gagel7_v_ang
Gage20_v_ang
Gage2l v_ang
Gage22_v_ang
Gage23_v_ang
Gage24_v_ang
Gage25_v_ang
Gage26_v_ang
Gage27_v_ang
Gage28_v_ang

150 200

Angle (Deg)

250

Gage29_v_ang
300 350




Map to Total Angle

15 Gage21

24 [] Angle

€ TFU Manager 7 x
TFU File | @ | ‘ D:fscratch/Metso/5065 Load Recovery/Test Data/showAngCycitest.tfu ‘ @ o GE @ ﬂ Walf Star Technnlcl-gies True- ri :‘_5{
Select Function Name ~
" el b

Angle Channel: aAngle

Degrees per Cycle:  (380.0

() Map to Cycles
(@ Mapto Angles Store Total Angle

Print progress |:| Replace Channels

Apply

Manage

Modify

= Ly o 28 W) By i

Math

ZA

Walltin vl 4 “NAM Aev /\0 N ly

%y

7y

|
yz

Plot Options
Simple - Legend Title: Mone ~ | Font Size: E ‘\I_
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Map to Total Angle

300 A 300 A
— Gage01 —— Gage0l_v_ang
—— Gage02 —— Gage02_v_ang
—— Gage03 —— Gage03_v_ang
—— Gage04 —— Gage04_v_ang
200 A 200 A
—— Gage05 —— Gage05_v_ang
— —
c —— Gage06 c —— Gage06_v_ang
.('U —— Gagell ‘o —— Gagell v_ang
o 100 - Gagel2 o 100 —— Gagel2_v_ang
8 —— Gagel3 8 —— Gagel3 v _ang
b —  Gagel4d ad —— Gageld_v_ang
O —— Gagels O —~ Gagel5 v.ang
= -~ Gagel6 & -~ Gagel6_v_ang
—-C 0 —— Gagel7 c 0 —— Gagel7 v _ang
= —— Gage20 — —— Gage20 v_ang
© —— Gage21l © —— Gage2l v _ang
5 —— Gage22 5 —— Gage22 v ang
-100 | —— Gage23 -100 | —— Gage23_v_ang
—— Gagez24 —— Gage24_v_ang
—— Gage25 —— Gage25 v _ang
— GageZb —— Gage26_v_ang
-200 - -200 - — Gage27_v_ang
—— Gage28_v_ang
—— Gage29_v_ang
T T T T T T T T T T T T T T T T
20 40 60 80 100 120 140 160 180 0 25000 50000 75000 100000 125000 150000 175000
Time (s) Total Angle (Deg)



Perform operation €} Wolf Star Technologies True-Tools ? e
on a TFU file
instead of loading
it in session.

TFU File: i Test Datafshow AngCycftest.tu

&ngle Channel: Angle -

Degress per Cycle: (3800

(@ Mapto Cycles

I
|ITi|]EI-I'T. i O Map to Angles Store Total Angle
:"ﬁ : Print progress
:-1:.3‘ |

\ Cutput TFU File: ta/showAngCycftest v_opclesifu

Apphy

Subtract Files

- Y

L .

[T )
N ]
Tale | AR

e to Cycles -

#»»»Al]l fTunctions converted.

S HE :l Srala { Erid Cinte Saving converted functions to file...

Converted functions written to:
D:/scratch/Metso/5865 Load Recovery/Test Data/showhAngCyc/test v cycles.tfu.




Dimension Plane




Gauge / Dimension Plane

Previously, the dimension
plane was constructed via
cross product with the
gauge normal. This
sometimes left dimension

floatingin space.

Dimensions are now drawn in the
plane of the gauge’s element.

Wolf Star Technologies True-Tools
Flename; headlamp-G-loads.odb
Parts: 6 Elements 556 Nodes 630







Hybrid Loading — No Gauges Needed!

* Previously, if you were doing Hybrid Loading, you would need
to place gauges that could back calculate the load — even
though you were measuring the load with another transducer.

* Now you do not need to include the Hybrid Load in your TLD
file or lay the extra gauges for the Hybrid Load.

 You do still need to model the unit load for the measured load
in your FEA model as a solved load case.

| © )



Hybrid Loading

) True-Load/Pre-Test

TLD File

Known Loa d QS EF i I e FEADB: | \FEAScooter-Unit-Loads_v3 odb

€ True-OSE
Session Tools

Event (QSE) File: | Ciscratch\ceeTron_deWCode Test\Benchmark 2023\Scooter\Test Data\Hyhrid\known_m_qse|| ® Sele'?t elements for % 12 elements picked %ﬁ %{f e
candidate gauges g

FEADB:
|..\..\FEA\Scooter—Unit—Loads_v3.odh | @ [] Shells Only Open as VTFx Store FEA

Stationary Loads Maving Loads

Bl|

Condition
Number |5'525

| Hide Load Table

Event Definition

FEA: FEA: Scale Mod Step Frame Scale Factor "
el
. S - Y FA—
| 1 1 |Unit-Loads:Load Case: FOOT-100N-FX-(1) - 1001 - 41.13802018808038
I Unit-Loads:Load Case: FOOT-100M-FY-(2) - 1002 - 1.0I <TFU File> Scooter_22_01_tfu==>Unit-Loa|
2 Unit-Loads Load Case. REARTIRET0ON-FY-@ < 1005 < 10 <TFU File> Scooter_22_01_tfu==>Unit-Log Unit-Loads:Load Case: FOOT-100N-FZ(3) - 1003 v 25.782433675339675
3 |Unit-Loads:Load Case: REARAXLE-100N-FX-(4) - 1004 T 32.30890380342375
u Step:  Unit-Loads:Increment ¥ | § Amplitude: | hybrid-Scooter_22_01_tfu==>Unit-Loads:Load 2 4 | Unit-Loads:Load Case: REARTIRE-100N-FY-(5) - 1005 > 1.0
e BT E T Amplltu Pl T | e -1 A - NEADTIODE ANAK 77 (2% Anne L AQOANELTALTNATA
[] Include Pre-Load Size: IE ."ﬂ Unit-Loads-Increment 0 Base State-(0) | Scale: % {: B D Enable Table Sort

Add Pre-Load
Plot Legend

A=

Subtract Pre-Load
Pre-Load State:

Shell Surface: (@ Top SPOS () Bottom SNEG

Gauge Placement

Min Distance between Gauges:

Scale Options
Choose Scales

Auto E-Scale

¥ o
TLD File: |atchfceeTron_defoode Test/Benchmark 2023/Scooter/TLD FiIesfrazorScooter_noFootF‘r’.tld| @ U (_‘,% @ (%) @

| @ [] Load Shells Only Open as VTFx Store FEA DB Relative Path

%[22 62

[] Plot Legend

Font Size:

. . . m # of Gauges: |42 = [E\ H Ht | (B zs B3| 8 2 :
Known Load is not in TLD File!!!! LA = S S T S LS R A Labels Ony
Test Simulation
NO Ga uges placed to sense known |Oad 111 %ﬁ’; ’ Event File Name | C:fscratchiTrue-Class - SA -orig/Example Files/Razor Scooter/Test Data}razorScooter—wst[][H_m_qse| @
9 ©2010, Wolf Star Technologies ALL RIGHTS RESERWVED Wersion: Ceetron 2023-10-19

-

»
< @




Post-Test Report Readability

&

€/|C|=|F

N J N J/

- -




2 @ D | o hbridicon-Search % | @ hybrid icon - Bing images % | [ aliCrossPlotshhiml - &
G @ O Ffile | Gfscratch/cesTron dev/Code%20Test/hlamp_GOI-hLampSimple-QSEhtmi A s & O m @ -
A Microsoft Azure  [] Entertainment @ Bing @ BingMaps & Google % GoogleMaps By Google Translate & Good
True-Load HTML file from Post-Test o

Report Written: Thu Dec 9 16:17:10 2021

X \ ] aCmssPIatshlml- [ True-Load Post-Test Report x S

L ‘ Q. hybrid icon - Search X | @ hybrid icon - Bing images
H Navigation: ‘ UnitLoad Table ‘ GaugeTable || TrmeLoad Desklop ‘ LoadPlots | Ouerall Staain Con (@] 0] (D File | Ciscrateh/ceeTron_dev/Code%20Test/Benchmark%202023/Scooter/Test%20Data/2022-08-19/razorScooter_update-hybrid-Scooter_22_01-D1.html Ay Q [
Required Input Files
True-Load File: C:/scratch/cecTron_dev/Code TesthLamp GOLtld M Microsoft Azure ] Entertainment @ Bing @ BingMaps & Google @ GoogleMaps [ Google Translate 4% Google Photos [] WolfStar [7] Banking [ Family % FitOn
Software Version: Ceetron 2021-11-17
Strain Data File: C Tron_dev/Code TesvhL QSE tfu True-Load HTML file from Post-Test
FEADB File (for r C/ h/ceeTron_dev/Code Test/headlamp-G-loads.odb Report Written: Fri Oct 6 08:31:13 2023
Hybrid Loading QSE file:
VTFx File: C fceeTron_dev/Code G-loads vtfi
Shells Only: Fals
e fae Navigation: Unit Load Table Gauge Table True-Load Desktop Load Plots Overall Strain Correlation Strain Correlation Quality Table Gauges of Interest
Output Files
Quasi-Static Event (QSE) File: \hLamp GOL-hLampSimple-QSE.qse
True-Function File (TFU) File: \hLamp_GOLhLampSimple-QSE tfu
HTML Report File: \hLamp_GOI-hLampSimple-QSE hunl Reguired Input Files Output Files
Simulated / M d Strain File: \hLamp_GOI-hLampSimple-QSE-SimMes tfu fequirec upul tles -

Hmaate casnred Shram e e B < True-Load File: hybrid-razorScooter_update tld Quasi-Static Event (QSE) File: _\razorScooter_update-hybrid-Scooter_22_01-D1.qse
Number of Gauges: 6 Software Version: Ceetron 2023-10-06 True-Function File (TFU) File: \razorScooter_update-hybrid-Scooter_22_01-D1 tfu
Condition Number of eMat: 3.215033711112599 Strain Data File: cratch\ceeTron_dev'Code Test\Benchmark 2023\Scooter\ Test Data\2022-09-19\hybrid-Scooter_22_01 tfu HTML Report Fil azorScooter_update-hybrid-Scooter_22_01-D1 html
Load Table: FEA DB File: EA\Scooter-Unit-Loads_v3.0db Simulated / Measured Strain File: .\razorScooter_update-hybrid-Scooter 22 _01-D1-SimMes.tfu
[Step [Frame|Frame Description Scale Factor VTFx File: EA\Scooter-Unit-Loads_v3 vifx Number of Gauges: 11
[Coad Case: GRAV-10GX||2 Load Case: GRAV-10GXFrame = 2|[1.0 Hybrid Loading QSE file: Condition Number of eMat: 2.387215
[Load Case: GRAV-10GY|[3 Load Case: GRAV-10GYFrame = 3|[2.947477610113982 Shells Only: False
[Load Case: GRAV-10GZ|[4 [Load Case: GRAV-10GZFrame = 4][1.285251199573817
e Lt Report Information Unit Load Table Gauge Table True-Load Desktop Load Plots Overall Strain Correlation Strain Correlation Quality Table Gauges of Interest

Gauge Table:

[Chosen Gauges eMat Strains
Gauge |Gauge El €] s net Strain Channel |SteP: Load Case: GRAV-10GX]Step: Load Case: GRAV-10GY/[Step: Load Case: | Load Table:

[Number|Name Label gle ain Channe Frame: 2 Frame: 3 Frame: |[Step Frame|Frame Description Scale Factor

[Bob_|I0 240|150 cot § 347785804989938e 05 0.00025125641582788335  |[0.0001901897193 |7y i T ads L oad Case: FOOT-100N-FX(1) 1001 ||Unit-Loads Load Case: FOOT-100N-FX~(1)Frame = 1001 30.10162563123969

2 1 19 |[p0-0000000000123 Go2 0.00017939647623640658 4.148260752845064¢-05 [0.00030246033689 — =
5 T 6 rmmeenn oo 0000255 273s610725251 0.0003523530367652525  Fo.0002099 70467 |[Unit Loads:Load Case: FOOT-100N-FZ(3) 1003 |Unit Loads:Load Case: FOOT-100N-FZ-(3)Frame = 1003 [24.506164001723665
|2 2 16 |[s9.99999999997524 Go4 -0.00015116028903718496 1.6928742874258576e-05 0.00013218690614 |[Unit-Loads:Load Case: REARAXLE-100N-FX-(4) 1004 |Unit-Loads Load Case: REARAXLE-100N-FX-(4)Frame = 1004 |[30.709563933834083
5 2 19 [90.00000000000793 ]GOS 000035659334659568373 __|[-0.00035659334659568373 _ [0.0003565933465 [Unit-Loads:Load Case: REARTIRE-100N-FZ-(6) |[1006 |Unit-Loads Load Case: REARTIRE-100N-FZ-(6)Frame = 1006 |[5.2165311460048285
6 Sue |0 71 |[5.599068339715134¢-12]G06 9.053314275717642¢-03 -0.0002830834028688475 0.00018113967046 |7 =2 T oad Case: REARTIRE-100NM-MY-(7)|1007 [Unit Loads Load Case: REARTIRE.100NMMY-(T)Frame = 100710

phat Window

|[ Report Information || UnitLoad Table | Gauge Table | TrueLoad Desktop | LoadPlots | Overall Strain Correlation || Strain Correlation Quality Table || Gauges of Interest ||

m = @& %

Gauge Table:

Chosen Gauges eMar Strains

G ~ El 4 Strai Step: Unit-Loads:Load Case: Step: Unit-Loads:Load Case: Step: Unit-Loads:Load Case: Step: Unit-Loads:Load Case: Step: Unit-Loads:Load Case:
‘““g: N Instance)| “i,":f“ |Angle Ch“"' . FOOT-100N-FX-(1) FOOT-100N-FZ-(3) REARAXLE-100N-FX-(4) REARTIRE-100N-FZ-(6) REARTIRE-100NM-MY-(7)
[mber|ame 8 anne Frame: 1001 Frame: 1003 Frame: 1004 Frame: 1006 Frame: 1007

o

1 2 5497 ||3.200000000000001 |ro, DroPPEd

2 2 2691 168.02521877683058 S];?:;(g Gauge 0.0003179123108947779 -0.00013072833765643953 3.656186842970702e-05 0.00012687736254194092 -0.00011664528275662094

3 2 18696 (|59.999999979727434 S:?:;(E Gauge -0.00011875410384063057 -6.749258027811764e-05 0.0002551820377148186 3.88800023983477¢-03 2.91071742647494e-05
‘,I i 1Q0AK1 SA QQRQASIVANTTAAR Chan#04 ﬂnﬂnl')'i;g')l’)nﬂ;"il"”?d S Q172/LI22AAT1LTSa NS N NNNYAAATIATANRNTSIAT 2 5NN T7I07ISA15TRa NS 2 eNTARARRLT TIARIQa NS

] I—

-
¢
o
[

o



Post-Test Report Readability

S — g' m M | @ hybrid icon - Search X | @ hybrid icon - Bing images X | [ aliCrossPlots.html X | [ True-load Post-Test Report ® [ True-Load Post-Test Report x  + — ] X

O ﬁﬂ O File | C:/scratch/ceeTron_dev/Code%20Test/Benchmark%e202023/5cooter/Test%200ata/2022-09-19/razor5cooter_update-hybrid-5cooter_22_01-D1.html Ad *ﬁ 5 Q {3 |:|:| Y:\E :":\’S @

A Microsoft Azure  [] Entertainment Q Bing @ BingMaps & Google 9 GoogleMaps By Google Translate % Google Photos [] WolfStar  [] Banking [7) Family % FitOn Q,

True-Load HTML file from Post-Test -
Report Written: Fri Oct 6 08:31:13 2023 | o
(<]
Navigation: Unit Load Table Gauge Table True-Load Desktop Load Plots Overall Strain Correlation Strain Correlation Quality Table Gauges of Interest

o7

Required Input Files Output Files “p’{

True-Load File: hybrid-razorScooter_update tld Quasi-Static Event (QSE) File: .\razorScooter_update-hybrid Scooter_22_01-D1.gse w

Software Version: Ceetron 2023-10-06 True-Function File (TFU) File: \razorScooter_update-hybrid-Scooter_22_01-D1.tfu
Strain Data File: C.'\scraich'\ceeTron_dev'Code Test'Benchmark 2023\Scooter' Test Data'2022-09-19\hybnd-Scooter_22_01.tfu HTML Repert File: .\razorScooter_update-hybnd-Scooter_22_01-D1 html +
FEA DB File: ..\FEA\Scooter-Unit-L.oads_v3.odb Simulated / Measured Strain File: .\razorScooter_update-hybrid-Scooter_22_01-D1-SimMes.tfu
VTFx File: .\FEA\Scooter-Unit-Loads_v3.+vtfx Number of Gauges: 11
Hybrid Loading QSE file: C:'scratch\ceeTron_dev'Code Test'Benchmark 2023\Scooter' Test Data'2022-09-19\Ctrl-razorScooter_update-Scooter_22_01-D1.qse Condition Number of eMat: 2.387215
Shells Only: False

I‘ Report Information ” Unit Load Table ”

Gauge Table ” True-Load Desktop H Load Plots ” Ovwerall Strain Correlation ” Strain Correlation Quality Table H Gauges of Interest |I

Frame||Frame Description Scale Factor
Unit-Loads Load 1001 |Unit-Loads-Load Case: FOOT-100N-FX-(1)Frame = 1001 39.10162563123969
Unit-Loads:Load Cj 1003  |Unit-Loads:Load Case: FOOT-100N-FZ-(3)Frame = 1003 24.506164001725665
Unit-Loads:Load g 1004 |Unit-Loads:Load Case: REARAXLE-100N-FX-(4)Frame = 1004 ||30.709563933834083
Unit-Loads:Load { 1006 |Unit-Loads:Load Case: REARTIRE-100N-FZ-(6)Frame = 1006  ||5.2165311460048285
Unit-Loads: Load, 1007 |Unit-Loads:Load Case: REARTIRE-100NM-MY-(7)Frame = 1007||1.0

Generated Output Data

Information ” Unit Load Table ” Gauge Table ” True-Load Desktop H Load Plots ” Ovwerall Strain Correlation ” Strain Correlation Qua

Chosen Gauges eMat Strains
Gauge ||Gauge Flement Strain Step: Unit-Loads:Load Case: Step: Unit-Loads:Load Case: Step: Unit-Loads:Load Case: Step: Unit-Loads:Load Case: Step: Unit-Loads:Load Case:
Vumgher \,ﬂmge I Label lAngle Channel FOOT-100N-FX-(1) FOOT-100N-FZ-(3) REARAXLE-100N-FX-(4) REARTIRE-100N-FZ-(6) REARTIRE-100NM-MY-(7)
B B Frame: 1001 Frame: 1003 Frame: 1004 Frame: 1006 Frame: 1007
R )Tﬂpp
1 2 5497 3.200000000000001 ||,y ed — — -— — —
2 2 2691 168.02521877685058 I(}hma::?j Gauge 0.0003179123108947779 -0.00013072833765645953 3.656186842970702e-05 0.00012687736254194092 -0.00011664528275662094 [m)]
3 2 18696 ||59.999999979727434 8&:;2? Gauge -0.00011875410384063057 -6.749258027811764e-05 0.0002551820377148186 3.88800023983477e-05 2.91071742647494e-05 @
bl 10041 <k 0eeeksran1Ta4 [|Chan#0d N ANN11230717085721 774 3 G172A8I20K18T5a NS N ANNIAAAT1A140RNTI1A4T 2 3AN1177077150157R= NS 7 QN10A1AAR1 72412 NS




Post-Test Report Readability

T s g' m M | @ hybrid icon - Search X | @ hybrid icon - Bing images x| [ aliCrossPlots.html x| [ True-load Post-Test Report ® [ True-Load Post-Test Report x  + — ] X p—
“ O m () File | Ci/scratch/ceeTron_dev/Code%20Test/Benchmark%202023/Scooter/Test%20Data/2022-09-19/razorScooter_update-hybrid-Scooter 22_01-D1.htm#Desktop a A s & & m 1= % " Ll))
A Microsoft Azure  [] Entertainment Q Bing Q BingMaps & Google 9 GoogleMaps By Google Translate % Google Photos [] WolfStar  [] Banking [) Family % FitOn Q,
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TFU Fatigue Units




TFU Fatigue Units
— O T Fatigue ? X ————
Damage gy .in Life | Damage @ Histogiam

Model: Calc: O Cycle—hy—CycIe 'LZI
Motch Factor: (@) () Range Start: |1.U | End: |2.[] | Increment:

| 1
Material DB:j WST Mats-Imperial.pkl ™ | | Hide / Show

L o o o o o o e - J
Material: | 1008-HR, SH-As-rec -BHME6 = x Plot: | Strain Life = f_.

Material Parameters

Material Name: 11008-HR_SH-As-rec -BHNB6 |

Units Lbf-in - . . . .
O, ——— » If using standard materials, switching
Fatigus Strength Exponent (o). [0.172  Unitess units will switch standard databases.
Fatigue Ductility Coefficient (<) |0.46 | Strain (Unitless)

Fatigue Ductility Exponent (c): |—U.543 | Unitless

Modulus of Elasticity (E)- |3.002e+07 | psi

Cyclic Strength Coefficient (K'): |2.093e+[]5 | psi

Strain Hardening Exponent (n'): [0.318 | Unitless

Yield Point(YP): 3.394e+04 | psi

Ultimate Strength (UTS): |4.801e+04 | psi

—-Calculated-

Transition Life (N): 1.5738+05 | Cycles (21)

Apply Cancel | i :



TFU Fatigue Units

d € TrU Fatigue

DaMa92 | Sirain Life

v |

Muodel:

Damage (@ Histogram
Calc:

? X

<

() Cycle-by-Cycle

Motch Factor: (@) () Range Start: |1.[] | End: |2.U | Increment:

| ————————
Material DBy |userMats.pkl Ty | Hide / Show

e o o o o o o o e e e e - 4

Material: ‘1015—HR,SH—Norm. -BHMB0-mod

Material Name:

Units

Yield Point(YP):

—Calculated--

Transition Life (M):

Modulus of Elasticity (E):

Ultimate Strength (UTS):

Material Parameters

/< Plot: Strain Life

| 1015-HR.SH-Norm. -BHMN80-mad

o

'Lbf-in

'| lUpdate Parameters

Fatigue Strength Coefficient(s;): |1.3e+[]5

| psi —

Fatigue Strength Exponent (b): |—U.12—‘l

| Unitless

Fatigue Ductility Coefficient (=) |U_T29

| Strain (Unitless)

Fatigue Ductility Exponent (c): |—U.581

| Unitless

|3.002e+07

| psi

Cyclic Strength Coefficient (K'): |1.3?1e+[]5

| psi

Strain Hardening Exponent (n'): |U.2‘13

| Unitless

3.307e+04

| psi

|6.005e+04

| psi

|7.436e+04

| Cycles (21)

Apply

Cancel

If using user materials, switching units
changes the unit base for the material.

If Update Parameters is checked, then

the parameters with units will have their
values updated to the new Unit System
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Huge Speed Increase!
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Reorganize Tools Menu




Reorganize Tools Menu

O Wolf Star Technologies True-Tools
True-Suite  Cloud Draw Style View . Tools
Widgets r
\f ):IL % % o -@ Measure Utilities
— Protractor
% Ruler

:ﬂ MNode Info
@ Element Info

Model Measurement and Probe Tools

Contour Style Contour

All Cross-Plots

Vector Result No selection @ CAEVTRx
Filter ~— M Generate Random Strains on TLD Tr u e_ LO a d TO O IS
Contour Vector ¥ Gauge Transform Wizard
Data Type | \* Print Current Working Dir
Data Component | [#  Change Working Directory . .
Data Location =2 Open Scratch Directory Directory / File Management Tools
" Clean Up Scratch Files
Single  Series  Options [
& Edit Config
. Update True-Load Software " .
@ (Check License Status A p p I ICat I O n SOftwa re TOO IS

3rd Party Plugins 4
w } © True-Tools Help
O About




Scratch Files




Scratch Files Restructured

Scratch files are now less intrusive.

They are kept out of the working directory by
default and deleted after two days.

& Edit Configurations ? be © Woit's = 0 X
Scratch files are now stored in the system TEMP s oscuro e
y feSafeoUI_mxE  fesafePath 03] WOLF STAR
folder by default. The True-Load scratch folder can e . DT
. . . . J i — zz
be changed in the installer, in the edit miser oot | i L T — ‘
configurations form (Tools menu), or in the et o e e
WOLFSTRR_LICENSE Wolf Star Technologies License | C:/TrueLoa wst2Llic Defauit work dir (for shortcut): |C:\Users\Annie\AppData\Local\Temp | & browse
configuration file (config. directly. I ——
g ( g py) y scratchlocation  Seatch Directory _ﬁ:_ ?Zﬁﬂ%ﬂ;?mﬂucﬁbr Ci/TrueloadApp/wst21.ic || @ browse
we | [ ew | = =

In the chosen scratch location, there is a top-level folder called “WST _scratch”. A folder for each True-Load
session is created in “WST _scratch”. Files shared between sessions are in the top-level “WST _scratch” folder.




The current scratch file folder
can be viewed with the

Open Scratch Directory

option in the Tools Menu.

€ Wolf Star Technologies True-Tools

True-Suite Cloud Draw Style View
I %% b S e
Results Mgr

Widgets
Measure Utilities

Stato Protractor
Contour Result Ruler
Contour Style Contour Node Info
Vector Result No selection

Filter Element Info
Contour Vector

All Cross-Plots
CAE2VTFx
Generate Rando

Data Type
Data Component
Data Location

NEO® BHI/I08

Single  Series  Options [ Gauge Transform Wiz

\> Print Current Working
[#_ Change Working Dire:

i r
w ..IS Open Scratch Directory | N 5

™ TeanUps ifes

& Edit Config
@ Update True-Load Software
®= Check License Status

3rd Party Plugins

Results Mgr ~ Group Mgr  Part M

>>> Scratch file top directory:
>>> Scratch file process direct] @ True-Tools Help
>>> Working directory:
------------------------------- €) About

Cleaning o

Open Scratch
Directory

» B L‘; S5 “ X X-Screen ~| 10

1

3 a3 - n
New item | [ig Open HH select all
X =] v
* 1) Easy access * 4 Edt Select none
y  Delete Rename  New Properties
- 5 & History Invert selection
Chpboard Organize New Open Select

T « Llocal > Temp > WST scratch > WST_scratch 25124 v O earch WST_scratch 25124

O nName Date modified Type

| WST_logFile.txt

# Quick access

& Dropbox

@ OneDrive - A

@ OneDrive - W
& Wolf Star Tec
= This PC

b Network

Al

item

h

Legacy format:

0ld process(es):

h\WST_scratch_25124

Current

scratch folder

Console Output ~ Python



Scratch Files Restructured

 Work folders containing WST_* files ¢ Huge advantage with this method:

will be purged of these files (moved — Multiple sessions of True-Load can be
to trash). run from the same directory.
e The Scratch folders in the system — Previously, session of True-Load in the

same directly could clobber WST_*
scratch files.

* To view the log file:

1. Choose Tools->Open Scratch
Directory

2. Open the WST logFile.txt

WST scratch directory will be
purged (moved to trash) if they are
older than 2 days old.

* This makes the work directory look
much cleaner.

* This aligns with the way most other
software work.

N ]



Square Axis Plotting




Square Axis Plotting

Function plots

# Format Curves Probe f Zoom Qut 'D_ ick E t . . g o
Sl The Square Axes option gives the x and y axes equal limits.

/ Legend Equal axes are persistent even when the axis limits are

v ig’i changed with the format menu or the drag and drop resize.
I
. YLog Axes have

R (T o S

equal limits

Plot Options

Smpe -/ ELegena The: FontSz2: (10 3| Scale / Grid Opts

7 Xlog
Function plots q unction x Grid

Square Axes option
in Plot Widget
Quick Format menu

Square Axes option
in TFU Manager
Plot Options
section

The square axes option is also exposed to the Python scripting
environment through the Plot.squareAxes attribute.
Plot.squareAxes is a Boolean setting the axes equal when True.




Measure Element to Element

g




Measure Element to Element

€) Wolf Star Technologies True-Tools
-
True Suite Cloud Draw Style  View ET001S I .és» | Element to element measuring is available in
o % % b o o = A - - i Measure Utilities.
|-‘53 Measure Utilities
| Doculic Bdnr I EEN———— |

The element selected will be outlined and
the centroid of the element displayed. The

€) Measure Utilities ? X . .

Py — ok Eoment 1 [T§ centroid of each element is used for
O Distance: Pt to Line — calculations.

() Distance: Pt to Plane Pick Element 2 [:\}

@ Distance: Element to Element

() Angle: 3 Pts

Console Output

(O Angle: 2 Lines
(O Angle: 2 Planes
(O Coordinates of Point

ptél = [-8.15315524, +1.19834372, +1.05302842]

O 3 PtArc pt02 = [-0.87112546, +0.54718163, -1.33124644]
O Centroid of Element del = 2.5737637614719246
| o & midPtel = [-0.51214035, +0.87276268, -0.13910901]

vecBl = [-0.71797022, -0.65116210, -2.38427486]
dx@1 = -08.717970222234726
dy@l = -0.6511620953679085
dz@1 = -2.3842748552560806




Reload Dim Params




Auto Saving Parameters

»<Home Dir> wsT userfiles > v
€ Dimension Gauges ? X o Name
i Ei : ¥y | (¥ _
Dim File: | <unt|lled>| @ O (’A} @ User Views
g icon_Try1_24x24.png
Geometry File: ':ralch\()nrk Screw\FEA\cnrkscrew_sim1—unil|c-ads_[:-p2‘ @ Shells Only g ‘%\ /= ’y o g icon_Try2_24x24.png
TLD File: | D-\scratch\Cork Screw\TLD Files\corkScrewr2.tid] ({4) Labels Only ~ N L] userMats.pid
S || userViews.pkl
Create Dimension  Modify Dimension  Auto Dimension | text Attributes ] WST_dimensionMgr_settings.bin
Gauge Lin Lin Angle Gauge| [in Plane 1 [:3 37 |Font Size: Color: . | ] WST_recentFiles.bin
Plane 1 Plane 2 Plane Label ; =
) = Decimal Places: -3 =
G G @y | =g Lin Plane 2: [} Iy I -
— IBackground O None @ Color: J
G0 n Angle Plane: l}, l lLocat -
ocation: |Mi M
cr0e = %é Preview @ Save | Line Attributes
s Ol ololo : o Location of settings file
G#04 O O O O JWidth: px Color: [}
‘Gauge Attributes
IL-ength: 0.5 | Width: px Color: .

Help Options
(7] - ALL RIGHTS RESERVED  Version: Ceetron 2023-10-19 ":::r

Parameters saved when

Dimensions are saved.




Reload Dimension Attributes

Previously saved attributes are reloaded

) Dimension Gauges

DimFiIe:| <untitec>] (@) ) R O ()]

Geometry File: scratch/ceeTron_dev/Code Test/headlamp-G-loads.odb @ Shells On N hly i
Y Fiec | - F’ (QiDseeoy T[S [ 2] = Sl
TLD File: | C:/scratch/ceeTron_dev/Code Teondeormal.tId| @ Labels Only = Labels Only ~
—_— —_— —_— —_—
Create Dimension  Modify Dimension  Auto Dimension Text Attributes I Text Aftributes
Dimensions Gauge: G#01 .|  FontSize: Color: _| Font Size: color: [
Dimension Type: Linear - Decimal Places: IDecimaI Places: E
Reference Plane: Rf Lfd Background (O None @ Color: J IBackground (O None @ Color: J
Offset: | +/- [1.0 | Location- Middle - ILocation: Ref Plane End ~
e e Line Aftributes Line Attributes
< Preview ’*\\;" Save ArTows: | |<—xxx —>| ~ Arrows: |—>| x.xx [$— ~
Width: px Color: . IWidth: px Color: .
Gauge Aitributes I Gauge Atiributes
Length: Width: px Calor: . ILength: Width: px Color: .
Help Options I I I S S S S . J
(7] ©2010, Wolf Star Technologies ALL RIGHTS RESERVED  Version: Ceetron 2023-10-12 ‘:} bn: Ceetron 2023-10-12 ’:’v

¥



STL Gauges




€ Gauge Line Specifications ? X

ExportType: | | Gaugelinecsv [ | 3Pointcsv | | PunchxmL 51 | [] Process Gois

Standard gauge shapes
with units are available
in the “Gauge Box”
option. The Gauge Box
STL export offers strain
gauge shapes and units
to choose from.

Cutpys==-' - == l=y\Code Test

Standard gauge options

Punch XML 3D 5TL

The STL file is used for importing gauges into CAD Systems.,
This is @ 30 solid faceted representation of the gauges.,

Length: |14.0 | B 2s0uwa ~

—_— — L] — —_— q
width: 8.9 [l ~l% O nches @ wilimeters

Depth: |2.80000000000000{ (20 v | % O Feet () Meters
— —_— — —_—

|:| One STL per Gauge STL with all Gauges

Unit options

Apply Cancel

Gauge specificationsfrom https://micro-measurements.com/pca/




Wolf Star Technologies True-Tools
True-Suite  Cloud Draw Style View Tools

S 4% % o500 @ -0 m A D—*\E@éu‘liuwlx)@&:veen

Results Mgr & x

Q] Pt G NV X P P sar | om

pMat Window
State Unit-Loads Increment 0- Base State-(0) + O Ttosdpre e CA D / F E A
Contour Resut N9 saiscton . TLD File: @ [ Colscratchheadlamplheadiamp-Gloads £id | @ O . .
g . FEADB: | loads.odb ] @ [] Load Shells Only [7] Open as VTFx [] A p p | I Ca t' O n
Vector Result | No selection - -l =

Filter

Session Tools

LIS

Select elements for

Condition
candidate gauges

El [ Number

1% | 6 elements picked | &

Data Type o X
Data Component - Stationary Loads Movi
v © Gauge Line ? %
Data Location v
| EportTyper [] Gougetinecsv [] 3Pointesy [ Punchsatt [] 30571 | [] Process GOIe
Single  Series  Options [ 1] 1 Unit-Loads:Load Case
Output Foider: [Gi\scratchiheadiams =

2 Unit-Loads'Load Case.

3ptosv | PunchxmL | IDSTL

3 Unit-Loads Load Case

The STL file s used for importing gauges into CAD Systems.
This 52 30 soid faceted representation of the gauges.

7 Unit-Loads:Increme| / Length: W osowa ~
o
Shell Surface: @) Top SP N GugeBax T with: @ v[w @ e O milmes
o cmaar] (8 %] 5 O ros O

STLwith ol Gauges

s ¢eop

Gauge Placement

z # of Gaug) [ ©ne 5L per Gauge
% ¢

Tens:

Appiy Cancel
Test Simulation

38 || gvent Fite Name Begin typing for rece]

Results Mgr ~ GroupMgr  Part Mgr XY Mgr L2 ©2010, Wolf Star Technologies ALL RIGHTS RESERVED Version: Ceetron 2023-10-20

Console Output

Updating Scale Factors

> 0.433
> 0.021
eScales
pscales

: Calculating scales ...

Scales done.

[+1.660000+00 +2.535124e+00 +1.221638e+40 ]
= [+ +3.

Launching Gauge Line Options...

Console Output

Python



Post- Purge Intermediate Files




Purge Intermediate Files
Hybrid and Contact Control

Purge Intermediate

Files Option

The Hyb r|d Loa d i nga nd Test Data Management  Hybrid Load Management ~ Moving Load Management  Conta

Contact Control processes Hybrid Load QSE File: | Begin typing for recent files.

1
Purge Intermediate Files

Create intermediate files- The l:l CalDUlatE Residual LDading
“Purge Intermediate Files”

checkbox in each tab moves
all auxiliaryfiles to the system
tra Sh, leavi ngon Iy the result Test Data Management  Hybrid Load Management ~ Moving Load Management  Contact Control
files.

Contact Control File: }ch\ceeTron_dev\Cade Tesl\hLampGIoadsODB_ctc‘ 5 ﬁ (_)

, Refresh Load Table

Purge Intermediate Files

Step Frame Oper;:

Purge Intermediate

Files Option



Hybrid Example

| 4 = | Hybrid1 Starter files before Post-Test

Home Share Wiew
* u & Cut i x I Y New item ~ ‘*‘";I i4 Open H select all

W] Copy path ﬂ Easy access * Edit 15 Select none
Pin to Quick Copy Paste Move Copy Delete Rename Mew Properties ) )
access [7] Faste shortcut to to - folder - & History :|'-' Invert selection
Clipboard Organize MNew Open Select

<« v g <« scratch » ceeTron_dev » CodeTest » Benchmark 2023 » Scooter » Test Data » Hybrid Search Hybrid 1

Strain Data

I Desktop £ ™ Name Type
= Documents ’ o GOI_Test_01.tfu 10/15/2023 6:19 AM TFU File
& Pictures - | known_01.grp 9/29/2023 12:11 PM Microsoft Program Gro
TimHunter - I known_01.qgse 9/29/2023 1211 PM (I5E File
scratch - 2 known_01.tfu . 8/28/2023 12:11 PM TFU File
Reprise -
staticnary and ternplates -
Known Loads QSE
WST_CEM - Q
Trust and Related Docs -
4 - Headlamp
Hybrid 1
L 4 >

Lt allme

4 items State: BR Shared



Hybrid Example

Purge Intermediate Files Option - UnChecked Purge Intermediate Files Option - Checked

I Mew item = ' il Open HH sl 5 New item = ' id Open HH sele
: B X Ik s B X A
ﬂ Easy access = - Edit 0 Sel ﬂ Easy access - Edit 10 Sel
Move Copy Delete Rename Mew Properties ) Move Copy Delete Rename Mew Properties )
tor  to - folder - @History o Inv tor  to - folder - @ History - Invg
Organize Mew Open Organize Mew Open 3
v+ CodeTest » Benchmark 2023 » Scooter » TestData » Hybrid 1 w | v+ CodeTest » Benchmark 2023 » Scooter » Test Data » Hybrid 1 w |
o Mame Date modified o Mame Date modified
razorScooter_GOI-hybrid-GOI|_Test_01-pics 10/20/2023 3:21 PM razorScooter_GOI-hybrid-GOI|_Test_01-pics 10/20/2023 3:26 PM
o GO _Test_01.Hu 10/15/2023 6:19 AM o G0 _Test_01.tHu 10/15/2023 6:19 AM
I o hybrid-G0OI| Test 01.tu I —____10/20/2023 3:21 PM [] known_01.grp 9/29/2023 1211 PM
| known_01.grp g/207 M g I nte rmed i ate I known_01.qze 9/29/2023 12:11 PM
T known_01.qse 9/29/2023 12:11 P Fi | ac % known_01.tfu 9729/2023 1211 PM
% known_01.tHu 9/20/2023 1211 P e razorscooter_GOI-hybrid-GOI_Test_01.html 10/20/2023 3:29 PM
e razorscooter_GOI-hybrid-GOI_Test_01.htrml 10/20/2023 3:23 8 I razorScooter_GOI-hybrid-GOI_Test_01.qze 107202023 3:29 PM
T razorScooter_GOI-hybrid-GOI_Test_01.qse 10/20/20 o razorScooter_GOl-hybrid-GOI_Test_01.tfu 10/20/2023 229 PM
o razorScooter_GOI-hybrid-GOI_Test_01.tfu 10 023 3:23 PM o razorScooter_GOI-hybrid-GOI_Test_01-SimMes.tfu 10/20/2023 3:29 PM
o razorScooter_GOI-hybrid-G0OI_Test_01-SimMes.tfu 10/20/2023 3:23 PM
EE SimTest-hybrid-razorScooter_GOl.csv 10/20/2023 3:21 PM

o SimTest-hybrid-razorScooter_GOltfu 10/20/2023 3:21 PM




| + | Contact 1

Home Share Wiew g o
£ 4 Cut Y TP ' . Open H select all
* : i \"';I f
A

Copy path - ﬂ* Edit 1 Select none
Pinto Quick Copy Paste Move Copy Delete Rename Mew Properties ] )
access [#] Paste shortcut to to - folder - £ History :,'—' Invert selection
Clipboard Organize Mew Open Select

y « CodeTest » Benchmark 2023 » Scooter » Test Data » Contact v

Strain Data

]

&= Pictures Mame

TimHunter

o GOI_Test_01.tfu 10/15/2023 £:19 AM

scratch

Reprise

stationary and templates
WST_CRM

Trust and Related Docs

% % % % N N N

4 - Headlamp
Hyhbrid 1
Installer

1 itermn State: B& Shared =2 =]




=
Mowve
to

x I V;I i Open - HH Selectall x I “’;I i Open - HH Selectall
ﬂ* - Edit 1 Seledt none ‘::I ﬂ* - Edit 1 Select none
Copy Delete Rename Mew Properties Move Copy Delete Rename MNew Properties
to - folder & History :,'—' Invert selection to to - folder - & History :f—' Invert selection
Organize Mew Open Select Organize Mew Open Select
aoter » TestData » Hybrid1 » w | 0 J2 Search Hybrid 1 aoter » TestData » Contact1 » w | 0 O Search Contact 1
Fa o~
Mame Date modified e Marme Date modified

]

razorScooter_GOI-GOI_Test_01-pics

razorScooter_GOI-hybrid-G0I|_Test_01-pics

4 Ctrl-razorScooter_GOI-GOI_Test_01.qse
o Ctrl-razorScooter_GOI-GOI_Test_01.tfu

o G0 Test 071.tfu

|_" razorScooter_GOI-GOI_Test_0.grp

e razorscooter_GOI-GOI_Test_01.html

" razorScooter_GOI-GOI_Test_01.qgse

* razerScooter_ GOI-GOI_Test_01.Hu

* razorScooter GOI-GOI Test 01-SimMes.tfu

e razorscooter_GOI-hybrid-GOI_Test_01.html
T razorScooter_GOI-hybrid-GOI_Test_01.qze
o razorScooter_GOIl-hybrid-GOI_Test_01.tfu

o razorScooter_GOI-hybrid-GOI_Test_01-SimMes.tfu

07 20/2023 3:30 PW

10/20/2023 3:39 PM

10/20/2023 3:39 PM
10/20/2023 3:40 PM
10/20/2023 3:44 PM
10/20/2023 3:44 PM
10/20/2023 3:44 PM
10/20/2023 3:44 PM

Intermediate
Files

razorScooter_GOI-hybrid-GOI|_Test_01-pics
o GO _Test_01.tfu
o razorScooter_GO|-hybrid-GOI_Test_01.html
I razorScooter_GOI-hybrid-GOI_Test_01.qze
o razorScooter_GOl-hybrid-GOI_Test_01.tfu
o razorScooter_GOI-hybrid-GOI_Test_01-SimMes.tu

10/20/2023 3:50 PM
10/15/2023 6:19 AM
10/20/2023 3:52 PM
10/20/2023 3:52 PM
10/20/2023 3:52 PM
10/20/2023 3:52 PM




Purge Intermediate Files Benefits

e Saves disk space from unneeded files

* Greatly reduces confusionin interpreting results. | have had

customers use the wrong files after Contact Control, because
they didn’t understand which file was the “Answer”.



FEA Browse




QSE: Browse for DB

€ Select model files X
€ True-QSE
T « Windows (C:) » scratch * ceeTron_dev * Code Test ? v O O Search Code Test
Event (QSE) File: | C:\scratch\ceeTron_dev\Code Test\hLamp
= == Organize ~ New folder =~ m @
i ‘hlceeTron_devlCode TesUheadIamp—G—loads—ODB_odbl @ [] Shells Only “ w A
oJ (] MName Date Type
Event Definition -
FEA- FEA- 9/7/2023 9:49 AM File fo
Step Frame /30/2023 11:04 AM File fo
1 Unit-Loads:Load Case: GRAV-10GX-(1) ~ 1001 - Filtered on Current 8/21/2023 8:55 AM File fo
. 8/16/2023 11:15 AM File fo
2 Unit‘LOadS:LOad Fand o AW Wa¥ad VN e kY LN aTalel
FEA D B FI Ie Type 5/10/2023 3:37 PM File fo
3 | Unit-Loads:Load 5/10/2023 3:36 PM File fo
5/10/2023 2:10 PM File fo
hLampGloadsODB-hybrid-SimTest-try 4/27/2023 911 AM File fo
U Step: Unit-Loads:Incremer ~ | Scale: 1.| Amplitude: SimTest-try1_tfu==>U annieTestGaugeName-SimTest-try1-D4-D 4/27/2023 9:04 AM File fo
__pycache__ 4/5/2023 939 AM File fo
Results Generation WST_scratch 4/5/2023 9:23 AM File fo
[ Include Pre-Load N 1415093 855 Al .
* ew--- /472023 8:52 AN File fo
| |0 | In o Add Pre-Load _ )
. Scratch files 4472023 8:03 AM File fo
’ Subtract Pre-Load ANITEST £/29/2023 357 B et
] % ) ) a3f £ 3 o2l FIV rle 1o
Lu% % L g Pr&Load State- bl mmmemn Tl omemn AT bl Tl m o Anf AN A Ol Tnmd b ol Clamn b A B /NN WTIC NkA Ml £~ N
Unit-Loads:Increment 0: Base State—( v < >
| L] | L] | L]
Help Options File name: \ ~8 | ABAQUS ODB File(*.odb) Y1
7] ©2010, Wolf Star Technologies ALL RIGHTS RES[IxEF  —— —-— s -
Open Cancel

S | © )



Pre: Browse for DB

€) True-Load/Pre-Test — X
TLD File: | C-\scratch\cesTron_deviCode TestodbNormaitid] () (F) (5) () (<) (@)
1 e E ) Select model files e
FEA DB: FcralchfceeTron_dewCode TesUheadIamp—G—loads_odtl @ Load Shells Only
s T <« Windows (C:) » scratch > ceelTron_dev » Code Test ? v (9] £ Search Code Test
Select elements for ; % r Col
candidate gauges [% HEETIENE TOEL [ Nu| i L
Organize ~ New folder =~ [ 0
Stationary Loads Moving Loads S D Napd Date Type ~
1 |Unit-Lga p/7/2023 949 AM File folder
H /3072023 11:.04 AM File folder
2 |Unit- T
g Flltered On Current B/21/2023 8:55 AM File folder
3 |Unit- .
FEA DB File Type B/16/2023 11:15 AM File folder
b/10/2023 3:37 PM File folder
1 Unit-Loads:Increment 0: Base State-(0) ~ Scale: & | L (= 5/10/2023 3:36 PM File folder
f [ 3 (5] § Fi
Shell Surface: @ Top SPOS (O Botiom SNEG Min Distalf >/10/2023 2:10 PM & folder
hLampGloadsQDB-hybrid-SimTest-t /2772023 911 AM File folder
Galge Placem;ntf - annieTestGaugeMame-SimTest-try1-D4- 0% 472772023 9:04 AM File folder
Z ls) auges:__ e [Be ES EW] [E EEMEDS _
- My - / cache, ¢/5/2023 939 AM File folder
‘&4 @ Tensors: [] Refresh S 5 Q o | % Y —by — £ 2 Y B
WST _scratch /2023 923 AM File folder
Test Simulation
MNew--- P23 852 AM File folder
%’ [ Event File Name ‘ C:/scratch/ceeTron_dey . .
= Scratch files File folder
7] ©2010, Wolf Star Technologies ALL RIGHTS RESERVED  Versi ANITEST File folder
- T Film Fml A v
v £ B T T >
I _— —_— —_— —_— —_— L]
File name: | "~ | |ABAQUS ODB File(*odb) “
| — ] [

e (¥



Recent Files




Recent Files

ﬂ Wolf Star Technologies True-Tools
Recently used files are available for quick loading throughout the

True-Suite Cloud Draw Style View Tools
True-Load environment (persistent across sessions).

q"#%%ﬁa@:ﬁfb'@

Recent files are available anywhere there is a recent file prompt

All recent files are (“Begin typing for recent files.”) or a clock icon.

@ available with the clock

_ ' The 10 most recent files for each category are displayed.
@ buttonin the tool bar. BOrY Piay

Q True-Load/Pre-Test

@ r—_—_—
o

TLD File: | 5 Begin typing for recent Tiles.| ’6‘ @ @ ’@‘ @

Results Mgr ~ Group Mgr ~ Part Mgr XY Mgr
Session Tools

Console Qutput
>>> Scratch file process directory: C:\Users\amhun\AppData\LDcal\Temp\WST:scr‘atch\wsTiscra1 Sebcl Eka'ments fOf B — - —
ke divctory: Crsenmaestron s candidato gauges L8| 293 clemenis picked & |uf -
Cleanin 4 ld scratch files. ..
Legacy fi it

Gauge Placement In-form recent file prompts show

0ld process (es):
C:\Users\amhun\AppData\Local\Temp\WST_scratch\WST_scratch_35288 moved to trash.

C:\Users\amhun\AppData\Local\Temp\WST_scratch\WST_scratch_7120 moved to trash. "z @ # of Gauges: E* E* | %
E— X Tonsors: (7] Refresh | " files of the appropriate type.

©2010, Wolf Star Technologies ALL RIG




Recent Files

Recent files menus with the clock icon show paths relative to the working directory.
Hovering shows the full file path.

Relative File Path

&) Wolf Star Technologies True-Toaols

True-Suite  Cloud Draw Style View Tools Debug Tools
LS a%%  vdbIZoeN - [ln A @ & {5 § @, xXScreen -| 10 | - [@] ] €[ Psnapshot| G QN

T Contact Control Test\razorScooter_update-newTest.gse £ = =
Results Mgr ‘T LDE Files\hLamp-Time.lde

State \Increment  0: Base Si A odbNormal.tid

| Ch\scratch\ceeTron_dew\Code Test\Contact Control Test\razorScooter_update-newTest.qse i

i % setSguareTest.tfu
Contour Result |N0 selection R hlampGloadsODB.tfu
Contour Style | Contour 7 hLampGloadsODB.tlg
Vector Result |N0 selection A Razor Scooter\razg Al | Re C e n t
Filter I hLampGloadsODB
Contour Vector *v noisyDatatfu F C I M
Data Type | % SimTest-try1.tfu I e S e n u
I
Data Component | '|

Data Location | - |




Recent Files

In-field prompts show full paths to recent files when anything is typed in the field.

€ True-Load/Pre-Test — x>

r—_—_—_

TLD File: @ | =Etegintypingf[:JrrecentﬁIes.||® O G} @ (%) @ Type anyth|ng

Select elements for % | 203 elements - X
candidate gauges < 7%
100 Q0GB
Chscratch\ceeTron_deviCode Test\hLampGloadsODB.tld ~
Gauge Placement Ciscratch\ceeTron_deviCode Test\odbNormal.tld
. | Select elements f{ C:\scratch\ceeTron_dev\Code Test\Razor Scooter\razorScooter ondition ;5 Show Load Table <l
& !4 @ # of Gauges: e Eap % %‘ 52 | (Ba| By candidate gauges Ciscratch\ceeTron_dev\Code Test\headlamp_GOI_TLG_fine_ti limber “
F-¢ y . ’
s Tensors: [+ Refresh S | S 2 e | |S Chsaatch\ceeTron dev\Code Test\hLampGloadsODB- THRE

| Gauge Placemer Cscratch\ceeTron_dev\Code Test\Big TLD\arm-un

# Cscratch\ceeTron_dev\Code Test\hLampGload
; A Y S s o o
© ©2010, Wolf Star Technologies ALL RIGHTS RESERVED Version: C % N Tonsors: o] Refresh |
©2010, Wolf Star Technologies ALL &)

S | © )



Python

[ o Scripts\plotMany.py
[ o Scripts\plotFunction.py

e Scripts\helloWorld.py
| Chscratch\ceeTron_dev\Code Test\Scripts\helloWorld.py i

=352 | = Ji| '6})' I
Python Console Output
runcode (open( 'C:\scratch\ceeTron_dev\Code Test\Scripts\hellolor] Loading Groups. ..
Storing: WST_Gauges
___________________ Storing: WST Candidates Clicking afile ina
Groups loaded tf'l
recent tiies menu
>>» Checking in Reprise... a 0
< > >»>>» Reprise Check In OK Wlthln d mOdUIe Opens
>3 Module:True-Load oy o
:>:>>| | = .‘::.) (& >> Reprise Check In Status:@ |t N that mOdUIe
Hello World




Recent Files

t} True-Load/Pre-Test

TLD File: | Bogin typing for recent fies] | ()| ) Select a recent file from a

— . .
FEAD[ & 7 prompt with a click or
rue-Load,/Pre-Test
arrow and ENTER keys.
Select d TLD File: | ®
candids Chscratchh\ceeTron_deviCode Test\odbNormal.tld ~
) Chscratch\ceeTron_deviCode Test\hLampGloadsODB.tld
FEA DE B T\ err=trbt raa e Aot T rAds Tact B armr Srmmtori ra=mrSemmdtar g =4a 1lH ] as V-

t} True-Load/Pre-Test
Select 4

candidg TLD File: C:\scratch\ceeTron_deviCode TestihLampGloadsODB tid @
Chscratchh\ceeTron_dev\Code Test\odbMormal.tld '
Chscratch\ceeTron_dev\Code Test\hLampGloadsODEB.tld
ChscratchiceeTron_dev\Code Test\Razor Scooter\razorScooter_update.tld
Chscratch.ceeTron_dev\Code Test\headlamp_GOI_TLG_fine_time_testSimStra
Chscratch\ceeTron_dev\Code Test\hLampGloadsODB-THREEstates.tld
ChscratchhceeTron_dev\Code Test\Big TLDVarm-unit-loads.tid
ChscratchhceeTron_deviCode Test\hLampGloadsODB-TWOstates.tld

Stalld FEA DB: C-/scra

Select elements fi
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Selecting a file in the All
Recent Files menu opens that
file in its associated module.

If a file type is used in multiple

modules, the most common
module is chosen. For
example, TLD files are opened
in True-Load/Pre-Test even
though they are also used in
True-Load/Post-Test.



Recent Files

* Recent files save a lot of time:
— Folders don’t have to be navigated so much

— If TLD files and Test Data are kept in separate folders, then Post-Test
is easier to use with less navigating.

— This a big speed increase for such common thing that we use.
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Select functions
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Function Name

Select function
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Subtract TFU Files

€ TrU Manager

TFU File | ©)

© Subtract TFU Files ?a‘:xi Choose files

Subtract all functions

Select First TFU File: (Code Test/noisyData tfu| [ ! )
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Output TFU File Data_minus_SimTest-try1 tfu with the Subtract Files
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Apply
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O & 4 A AL 1
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| File saved
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